
THE VOLATILE LOS ANGELES RIVER  
is the reason that America’s second-largest city was founded in 
its present Southern California location by Spaniards in 1781. 
(The area was originally settled thousands of years earlier by the 
Gabrielino-Tongva Tribe, a California Indian tribe also known as 
the San Gabriel Band of Mission Indians.) Its water was tapped 
for drinking and irrigation, and a new city spread out from the 
river across the coastal plain. By the turn of the 20th century, the 
river was surrounded by a thriving urban center. Every few decades, 
raging floods would crest the banks at various points, submerging 
entire neighborhoods. After the historic floods of 1938 that claimed 
more than 100 lives and washed out bridges from Tujunga Wash to 
San Pedro (figure 1-1), city leaders had seen enough. By 1941, the 
US Army Corps of Engineers had begun to straighten, deepen, and 
reinforce the once wild waterway. Much of its length was eventually 
lined in concrete, and the river was more or less tamed.

Today, the City of Angels—home to nearly 4 million people—is 
a vibrant world center of business and culture. Running straight 
through the heart of the city, the Los Angeles River now serves as a 
flood control channel (figure 1-2). Sadly, this once bucolic waterway 
that was so instrumental to the formation of the city later became 
known as something ugly and marginal. Mile after mile of angled 
concrete appealed only to graffiti artists and filmmakers, and save 
for the occasional televised rescue of some hapless Angeleno swept 
away by a winter storm-fed torrent, the river remained a part of the 
city ignored by most. The negative perception has stuck with the 
neglected river for decades.

But in recent years, as the city has densified and much of Southern 
California’s wild lands have been appropriated for development, 
new attention has focused on the river corridor and the scattered 
pockets of open space that line its length. Although it must always 
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Figure	1-1.	The	historic	floods	of	1938	washed	out	bridges	up	and	
down the Los Angeles River, including this one at Colfax Street and 

Vernon Boulevard.

Photo by Los Angeles Times staff photographer. 
Copyright © 1938 Los Angeles Times. 

Reprinted with permission.
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serve its important flood control function, the river and adjacent 
lands are increasingly recognized as underutilized, providing 
opportunities for regreening and psychic restoration for people 
living in an overbuilt city. Adventuresome and resourceful citizens 
have discovered peaceful pockets of sanctuary along the river and 
made these places their own. A vital and concerned activist commu-
nity has raised awareness of the river and pushed for its beautifica-
tion and redevelopment. 

In 2005, the city launched a major public works project focused 
on the human dimensions of the river. A landmark study, the 
Los Angeles River Revitalization Master Plan, demonstrated the 
significant potential of redevelopment to improve the quality of 
life for citizens living near the river corridor. Then mayor Antonio 
Villaraigosa said at the time, “We have an opportunity to create 
pocket parks and landscaped walkways ... to create places where 
children can play and adults can stroll.”

According to Villaraigosa, “The plan provides a 25- to 50-year blue-
print for transforming the city’s 32-mile stretch of the river into 
an ‘emerald necklace’ of parks, walkways, and bike paths, as well as 
providing better connections to the neighboring communities, pro-
tecting wildlife, promoting the health of the river, and leveraging 
economic reinvestment.”

Although the 2005 master plan identified some of the most obvi-
ous areas for large-scale regional redevelopment along the river, it 
stopped short of identifying smaller (and more affordable) neigh-
borhood projects; that work would require a more involved study. 
With thousands of land parcels strung out along the river, identify-
ing the best places for park development is like looking for a needle 
in a haystack. Many factors come into play, among them current 
land use, demographics, and accessibility.

In the years since the plan’s completion, the city has created a web-
site (figure 1-3) that encourages people to learn about (and partici-
pate in) the latest developments related to its landmark resource. 
The website, at www.lariver.org, contains links to many resources 
about the river and its watershed, including scientific studies and 
recreational opportunities. If city leaders can find the resources 
and a motivated citizenry keeps up the pressure, a renaissance will 
transform growing stretches along the river into real versions of the 
revitalization effort's artists’ renderings (figure 1-4).

Figure 1-2. The Los Angeles 
River	now	serves	as	a	flood	
control channel though the 

river corridor is the focus of 
city regreening efforts.
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Figure 1.3. The Los Angeles River 
Revitalization website contains links 
to information about the river and its 
watershed.

Courtesy of the City of Los Angeles, Los Angeles River Revitalization Master Plan
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Here’s where you pick up the thread in this book. You’ll use the 
city’s real need for river redevelopment as a launching point for a 
park siting analysis using a geographic information system (GIS). A 
GIS is ideal for this type of decision-making because it allows you 
to analyze large amounts of data in a spatial context. In this book, 
you’ll spend a lot of time with ArcGIS Pro software, and by the end 
you’ll have completed a project from start to finish. Along the way, 
you’ll gain an excellent grasp of what a GIS can do.

You’ll be assuming the role of a GIS analyst for the City of Los 
Angeles. So what exactly does a GIS analyst do, and how is that 
job different from other jobs that also use GIS software? Table 1-1 
defines some of the various roles that a typical GIS operation might 
establish to accomplish its work.

Figure 1.4. The Los Angeles River Revitalization website contains artists’ renderings (A to C) of a rejuvenated river 
corridor.
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The central work in this book is analytical. Your main focus will be 
on using ArcGIS tools and methods to find the most park-suitable 
land within a study area, but there is preparatory work to do before 
the analysis proper, and there are results to interpret and present 
afterward. This book has two goals. One is to present a comprehensive 
approach to geographic problem solving. We want to help you develop 
skills, habits, and ways of thinking that will be useful in projects other 
than this one. The second goal is to teach you how to use ArcGIS 
Pro software. These goals are mostly complementary. ArcGIS is a big 
system, however, and it wouldn’t be realistic to try to cover all that it 
can do in a single book. Our principle has been to teach the software 
in the service of the project and not otherwise. You’ll delve into many 
aspects of ArcGIS Pro—editing, modeling, and cartography, among 
them—but there are other aspects that we won’t use, or will only 
touch upon lightly, because they aren’t strictly relevant to our needs. 
We might say (with apologies to Waldo Tobler1) that everything in 
a GIS is related to everything else, but some things are more closely 
related to analysis than others.

Frame the problem
The first step in the geographic approach to problem solving is to 
frame the problem. What that means, first of all, is coming up with a 
short statement of what it is you want to accomplish. For this project, 
you want to find a suitable site for a park near the Los Angeles River.

Once you have the statement, you can begin to tease out its ambigui-
ties. What factors make a site “suitable”? In this case, the city council 
has already established a concise and fairly specific set of guidelines. 

1.  Tobler, W. 1970. "A Computer Movie Simulating Urban Growth in the 
Detroit Region." Economic Geography 46 (2): 234–40.

Here’s where you pick up the thread in this book. You’ll use the 
city’s real need for river redevelopment as a launching point for a 
park siting analysis using a geographic information system (GIS). A 
GIS is ideal for this type of decision-making because it allows you 
to analyze large amounts of data in a spatial context. In this book, 
you’ll spend a lot of time with ArcGIS Pro software, and by the end 
you’ll have completed a project from start to finish. Along the way, 
you’ll gain an excellent grasp of what a GIS can do.

You’ll be assuming the role of a GIS analyst for the City of Los 
Angeles. So what exactly does a GIS analyst do, and how is that 
job different from other jobs that also use GIS software? Table 1-1 
defines some of the various roles that a typical GIS operation might 
establish to accomplish its work.

Table 1-1. GIS roles

Editors People who create, update, and correct spatial data and its attributes (statistical and 
descriptive information).

Cartographers People who make and publish maps and solve information design problems.
Analysts People who query and process geographic data to solve analytical problems.
Programmers People who implement custom GIS functionality by developing scripts and applications for 

specific procedures.
Managers People who oversee staffing and equipment, database design, workflow, new technology, 

and data acquisition.
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Park guidelines
1.  On a vacant parcel of land at least one-quarter acre in size 
2.  Within the Los Angeles city limits
3.  As close as possible to the Los Angeles River
4.  Not in the vicinity of an existing park
5.  In a densely populated neighborhood with lots of children
6.  In a lower-income neighborhood
7.  Where as many people as possible can be served

This list limits the scope of your inquiry, but it’s far from a complete 
breakdown of the problem. Some of the guidelines are specific, but 
others are vague. Familiar concepts are sometimes the hardest to 
pin down. For example, what income level should count as “lower 
income”? How are the boundaries of a “neighborhood” established? 
You can’t solve the big problem until you’ve solved the little prob-
lems buried inside. Usually, however, it’s not possible to address (or 
even foresee) all the little problems ahead of time.

Data exploration influences the framing of the problem. Do you 
have income data on hand? If so, is it for individuals or households? 
Is it average, median, or total? To the extent that the questions 
themselves are indefinite (What is lower income? How should it be 
measured?), the data you have available will help shape the answer.

Analysis also influences the framing of the problem. Given that you 
want a quarter-acre tract of vacant land, what do you do about adja-
cent lots? Is there a tool to combine them? If so, does using it have 
unanticipated side effects, such as a loss of information? Your data 
processing capabilities (and your knowledge of them) may deter-
mine how you define a “one-quarter acre parcel.”

Even the results of an analysis influence the framing of the prob-
lem. Suppose, after having carefully defined the guidelines, you run 
the analysis and don’t find any suitable sites. Do you report to the 
city council that there’s just no room for a park? More likely, you'll 
change some of your definitions and run the analysis again.

Framing the problem, therefore, is an ongoing process, one that will 
occupy you throughout much of the book.

Exercise 1a: Explore the study area
In this exercise, you’ll get to know the Los Angeles River and its 
surrounding area with maps and data. At the same time, you’ll learn 
the basics of working with ArcGIS Pro: how to navigate a map, add 
and symbolize data, and get information about map features.
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Start ArcGIS Pro 

Now you’ll open the ArcGIS Pro application.

▶ See the preface for how to install ArcGIS Pro.

1) Start ArcGIS Pro by clicking the Start button on the taskbar, 
and then, on the Start menu, click All Programs > ArcGIS > 
ArcGIS Pro > ArcGIS Pro. 

To open ArcGIS Pro, you must sign in to ArcGIS Online using an 
organizational account. Signing in to ArcGIS Online allows you to 
access and share GIS content with users in your organization as well 
as publicly with users around the world.

2) Click Sign In. 

The application opens with the ArcGIS Pro dialog box.

Create a new project

1) To create a new project, click Blank. 

2) Provide a New Project name: LARiver_ParkSite.

3) Browse to and select the UGIS (Understanding GIS) folder 
as the location to save the new project folder.

4) Click OK. 

Creating the project creates a new folder in the UGIS folder with 
the name you gave it, along with some default items, including a 
new geodatabase and a toolbox.

Insert a new map

1) On the Insert tab, click New Map. 

A new map is added to the project using the Topographic map by 
default.

On the right side of the application is the Project pane. This pane 
contains all the maps, data, tools, and other resources associated 
with the project. 

2) Open the Project pane (if necessary) and expand the Maps 
item. 

Note that a new map simply named Map has been added to your 
project. 

▶ If the Project pane is not displayed, go to the View tab and 
click Project.

3) Rename the new map by right-clicking Map in the Project 
pane and clicking Rename. Type Lesson1a and press Enter.
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Change the basemap to Streets

1) On the Map tab, change the basemap by clicking the 
Basemap button  in the Layer group. The basemap gallery 
is displayed with several different basemap options. 

2) Click the Streets basemap. 

The World Street Map basemap layer is added to your Lesson1a map. 
It has an entry in the Contents pane on the left. Again, click the 
View tab, if necessary, to open the Contents pane.

The Map tab at the top of the application includes tools for naviga-
tion, layers, selections, inquiries, and labeling. As different tabs are 
selected—Insert, Analysis, View, Edit, and Share—different tools 
will appear on the ribbon. Additional contextual tabs, including 
Appearance, Labeling, and Data, will appear depending on the 
tasks that you are performing.

Zoom in to Southern California 

Now you’ll zoom in to your area of interest. 

1) Experiment with navigating the map with 
the mouse.
A. Push the scroll wheel forward to zoom in.
B. Pull the scroll wheel back to zoom out.
C. Drag in any direction with the left mouse 

button to pan.
D. Drag up with the right mouse button to 

zoom out.
E. Drag down with the right mouse button 

to zoom in.
F. Press and hold the Shift key and drag a box 

with the left mouse button to zoom in.
G. In the map window, use the Shift key to 

drag to draw a box around Southern 
California, as shown in the figure. 

Your box doesn’t have to match exactly.
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2) Zoom in again to get closer. When you see city names and 
major roads, pan (left mouse button) to center the view on 
the Los Angeles area.

3) Keep zooming in (try the Fixed Zoom In button , too) until 
you can easily distinguish cities, freeways, and landmarks 
such as airports. 

4) If you zoom in further than you want, zoom out (pull the 
scroll wheel back), or click Fixed Zoom Out  in the 
Navigate group to go back.

You probably noticed that no streets were visible at the global scale, 
and that as you kept zooming in, more and more detail appeared. 
This is because the basemap is a multiscale map—really, a set of 
maps that turn on and off to display features and symbology that 
are appropriate to your map scale.

The figure shows Greater Los Angeles, an area that includes scores 
of incorporated communities and nearby cities.

Add a layer of project data 

On top of the basemap, you’ll add a layer from the data that has 
been put together for this project and is stored on your computer. In 
lesson 2, we’ll talk more about where this data comes from and how 
to acquire data of your own.

1) In the Project pane, right-click Folders and click  
Add Folder Connection. 

2) Browse to your UGIS folder and select the ParkSite folder. 
Then click OK. 

Selecting a folder adds a new folder connection to ParkSite.

3) After making the folder connection, expand ParkSite\
SourceData and then ESRI.gdb, and finally the Boundary 
item.

4) Drag and drop the City_ply layer on your map. Default layer 
colors vary so don’t worry if the color of your layer looks 
different from the figure. 

We’ll discuss GIS data formats in the sidebar “Representing the real 
world as data” in lesson 2. For now, you just want to dig down to 
your data.

Basemap layers

Basemap layers show reference ge-
ography such as street maps, imag-
ery, topography, and physical relief. 
The ones available in ArcGIS Pro 
are remotely hosted map services 
that you can navigate, view, and use 
as backdrops to other data. Base-
maps are stored at multiple scales, 
so that as you zoom in or out, you 
see different amounts of detail. As 
you navigate a basemap, the various 
pieces of it (called tiles) that com-
pose your current view are stored 
locally on your computer in a so-
called “display cache.” When you 
zoom or pan to a new area, the map 
may be a little slow to draw, but 
anyplace you return to will redraw 
quickly because the data comes 
from your cache, not from the re-
mote server.
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Set layer properties

Every layer has properties you can set and change. For example, you 
just changed the visibility property of the City_ ply layer.

1) In the Contents pane, right-click the color patch underneath 
the City_ply layer name. A color palette opens. Moving the 
pointer over any color square shows its name as a ToolTip.

2) On the color palette, click any color you like to change  
the layer color.

On the map, the cities redraw in the color you chose.

3) In the Contents pane, right-click the City_ply layer name 
to open its context menu. At the bottom of the menu, click 
Properties.

The Layer Properties dialog box opens. Here is where you access the 
full set of properties for a layer.

4) If necessary, click the General tab at the top of the left 
column on the dialog box.

The layer’s name, City_ ply, is one of its properties. This name is 
cryptic (it stands for “city polygons”) and unattractive, so now you 
can change it.

5) In the Name box, delete the text and type Cities.

Right-click here

When the layer of city boundaries is added to the map, it may zoom 
to the full extent of the dataset. If so, click the Previous Extent but-
ton  in the Navigate group on the Map tab.

Each city in the layer is called a feature. These features are polygons, 
which are one of the three basic shapes used to represent geographic 
objects in a GIS. (The others are lines and points.)

In the Contents pane, the order of entries matches the drawing 
order of layers in the map. City_ ply is listed above World Street 
Map, and on the map, the cities cover the basemap. You can control 
a layer’s visibility with its check box in the Contents pane.

5) In the Contents pane, click the check box next to City_ply.

The layer is turned off.

6) Click its check box again to turn the layer back on.
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6) In the Layer Properties dialog box, click the Source tab.

This tab shows technical information about the layer, including the 
path to the data on your computer.

7) Click OK on the Layer Properties dialog box to close it. 

Notice that the name is updated in the Contents pane.

Renaming the layer in the map simply makes it easier to identify in 
the map, it doesn’t change the source data file’s name (which is still 
City_ ply). A layer is a representation or rendering of the data, not 
the data itself. You can make any changes you want to a layer’s prop-
erties without affecting the data on which the layer is based.

Get information about cities

Now see what you can find out about the cities on the map.

1) Click any city polygon on the map.

The city flashes blue, and a pop-up window opens. In the title bar of 
the pop-up window, you see the name of the city you identified. In 
the pop-up window, you see its attributes, or the information that 
this layer stores about cities. Some of the attributes aren’t obviously 
meaningful, but others are. If POP2010 is population for the year 
2010, and POP10_SQMI is population per square mile for the 
same year, you know that Los Angeles (if that’s the city you identi-
fied) had 3,792,621 inhabitants at the time of the 2010 census, and 
its population density was 8,018 people per square mile. 

2) If necessary, move the pop-up window away from the map. 
Identify a few more cities.

The pop-up window updates with information about the new city. 
All the cities have the same set of attributes; it’s the values of the 
attributes that change.

3) Close the pop-up window.
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4) In the Contents pane, right-click Cities and click Attribute 
Table. 

5) Scroll across the table, if necessary, to look at all the field 
names (the gray column headings).

This is a different presentation of the same information you saw 
when you identified cities on the map.

6) Scroll back to the beginning of the table, and then scroll a 
little way down through the records (the table rows).

This table has a lot of records: in fact, 29,259 of them, as you can see 
at the bottom. Each record corresponds to a unique feature—that 
is, a unique city—on the map. So there must be a lot of cities you’re 
not seeing in the current view.

7) Leave the table open. It will stay docked under the Lesson1a 
map.

▶ You can move the panel by dragging it from the tab and 
redock it by dropping it on any blue arrow.

8) In the Contents pane, right-click the Cities layer. On the 
context menu, click Zoom To Layer.

The map zooms out to the geographic extent of the layer: the entire 
United States. You can’t distinguish individual city polygons at this 
scale.

9) On the Map tab, in the Navigate group, click the Previous 
Extent button.

Select the record for Los Angeles

When you select a record in an attribute table, the corresponding 
feature is selected on the map. (Likewise, when you select a feature 
on the map, its record is selected in the table.) Selections are marked 
with a blue highlight by default.

1) Scroll up to the top of the table. Make sure the table is wide 
enough that you can see the POP2010 field. 

▶ If necessary, widen the table by dragging its edge.

2) Right-click the POP2010 field name. On the context menu, 
click Sort Descending. Alternatively, double-click the 
column header to switch between the ascending/descending 
sort order.

The records are sorted in the order of their populations, from largest 
to smallest. Los Angeles is now the second record in the table, after 
New York.

3) At the left edge of the table, click the small gray box next to 
the Los Angeles record to select it. 

On the map, the city of Los Angeles is outlined in blue. You may be 
able to see the whole city already, but now you can make sure.

4) Close the attribute table by clicking the X on the right of 
Cities.

5) In the Contents pane, right-click Cities and click Selection > 
Zoom To Selection.
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The map zooms in close on the selected feature and centers it in 
the view. The city’s odd shape is attributable to years of piecemeal 
expansion and incorporation. The city has internal “holes” where 
it surrounds other cities, such as Beverly Hills, or unincorporated 
areas. It also has a long, narrow southern corridor that connects it 
to its harbor at the Port of Los Angeles. 

6) On the Map tab, in the Selection group, click the Clear 
button  to unselect the feature.

Filter the display of cities using a definition query

One of your project requirements is that the new park be inside 
the Los Angeles city limits. Therefore, you’re more interested in 
Los Angeles than in other cities. A layer property called a definition 
query allows you to show only those features in a layer that interest 
you.

1) In the Contents pane, right-click the Cities layer and click 
Properties.

2) In the Layer Properties dialog box, click Definition Query.

3) Click Add Clause to begin building your query.

You build a query on an attribute table by specifying a field and set-
ting a logical or arithmetic condition that values in that field must 
satisfy. In this case, you want to find records with the value of Los 
Angeles in the NAME field.

4) In the list of field names, use the drop-down arrow to click 
NAME.

5) Click is Equal to in the second drop-down menu.

6) Type Los Angeles in the third box. You can also use the menu 
to select the city name.

7) Click Add. Do not click OK yet.
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8) Click the General tab.  
Delete the layer name  
Cities and type  
Los Angeles. 

9) Click OK.

On the map, only the city of 
Los Angeles is shown. The 
other cities are hidden by 
the definition query. 

10) In the Contents pane, right-click the Los Angeles layer and 
click Attribute Table. 

The table shows only the record for Los Angeles.

11) Close the attribute table.

The other city features haven’t been deleted. Clearing the definition 
query would display them again. Layer properties affect the display 
of data in a map, not the essential properties of the data itself: the 
number of features, their shapes, locations, and attributes. 

Add a layer of rivers 

Now you can add a layer of local rivers to the map and see where the 
Los Angeles River fits into the picture.

1) From the Project pane, browse to the Hydro group in the 
ESRI.gdb and right-click the River layer. Then click Add To 
Current Map from the menu.

A layer of rivers is added to the map and placed at the top of the 
Contents pane. The layer is symbolized with a random color; if the 
color is difficult to identify, it may be beneficial to change its color 
using the color palette (if you are having trouble, refer to the task “Set 
layer properties,” steps 1 and 2, earlier in this section, for instructions). 

2) Click on any river to identify it.

You see the name of the river (many of them don’t have names) and 
its other attributes.

By default, the Explore tool identifies features from the topmost 
layer in the Contents pane. If you miss a river, you’ll identify either 
the city of Los Angeles or nothing. That’s fine—leave the Explore 
window open and click again on a river. 

Layers and datasets   

A layer points or refers to a dataset 
stored somewhere on disk (as spec-
ified on the Source tab of the Layer 
Properties dialog box). A layer is not 
a physical copy of the data. A layer is 
a representation or rendering of the 
data. The dataset stores the shapes, 
locations, and attributes of features; 
the layer stores display properties, 
including what the layer is named, 
which of its features are shown or 
selected, how those features are 
symbolized, and whether they are 
labeled. Changes to layer proper-
ties do not affect the dataset that 
the layer refers to. You can make as 
many layers as you want from the 
same dataset and give them differ-
ent properties. These layers can co-
exist in the same map document or 
in many different map documents.
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3) Click on a few more rivers to identify them. Try to identify a 
segment of the Los Angeles River.

The river runs west to east across the city, turns south near the city’s 
eastern edge, and follows a freeway to San Pedro Bay.

4) Close the pop-up window.

Make a definition query on the LA River

Just as you’re mainly interested in one city, you’re also mainly inter-
ested in one river. You’ll make another definition query to show just 
the Los Angeles River.

1) In the Contents pane, right-click the River layer and click 
Properties.

▶ A shortcut is to double-click the layer name in the Contents 
pane.

2) In the Layer Properties: River dialog box, click Definition 
Query.

3) Build your query:
Name is equal to Los Angeles River.

4) Click the General tab. Change the layer name from River to 
Los Angeles River. 

5) Click OK.

The Contents pane reflects the new layer name.

▶ You can also rename a layer directly in the Contents pane by 
clicking the name once to highlight it and then clicking it again 
to rename it. (Be careful not to double-click, or you’ll open 
the layer properties.)

Change the symbology

1) Click the color symbol below the Los Angeles River name 
to modify the symbol. Clicking the symbol opens the 
Symbology pane on the right side of the map.

2) Click the Properties tab at the top. Under Appearance, you 
can change the color and width of the symbol.

3) Change the color to blue.

4) Change the line width to 3 pt.

5) Click the Apply button and close the Symbology pane. 

On the map, the river is displayed with its new symbology.

Select Los Angeles River features using a query 

On the map, the river looks like a single feature (just like the city), 
but it’s not.

1) In the Contents pane, right-click the Los Angeles River layer 
and click Attribute Table.

At the bottom of the table, you see that 0 of 17 records are selected. 
That means that, in this particular layer, the Los Angeles River is 
composed of 17 features. Why is that?

2) Scroll down through the table. 

All the records have the same name value. Most have the same 
type, but one is an artificial path. There are a few description values. 
The need to maintain different attribute values for different parts 
of a geographic object is a common reason that data—especially 
data representing linear features such as streets and rivers—is 
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constructed this way, consisting of multiple features. We’ll come 
back to this point in lesson 2. 

3) In the ribbon of tools on the Map tab, in the Selection group, 
click the Select By Attributes button .

Having noticed “perennial” (year-round water flow) and “intermit-
tent” (not year-round water flow) values in the description field, you 
might want to know which parts of the river are which. You can 
find out using an attribute query. An attribute query is like a defini-
tion query in that both types of query single out features in a layer 
on the basis of attribute values. The difference is that an attribute 
query highlights (selects) features that satisfy the expression rather 
than hiding features that don’t. 

4) In the Layer Name or Table View box, confirm that Los 
Angeles River is selected.

5) Make sure the Selection type drop-down list is set to New 
selection.

6) Click the Add Clause button. 

7) Create a clause for 
Description is equal to perennial.

8) Click Add. 

9) Click Run, in the lower-right corner of the pane. 

Twelve records are selected in the table. The corresponding features 
are selected in the map, showing that the river is perennial for most 
of its length.

It’s not among your guidelines to locate the new park along the 
river’s perennial stretch, but it’s interesting that fairly simple 
data exploration may introduce new ways of thinking about your 
problem.

10) Close the Select Layer By Attribute Geoprocessing pane. 

Find the length of the perennial portion of the LA 
River

As you learned by looking at the attribute table, the perennial por-
tion of the LA River is separated into 12 distinct records. To find 
the total length of this section, you must perform a summation of 
the FEET fields, using the Summary Statistics tool. When features 
are selected in the layer, the Summary Statistics tool processes only 
the selected records as a subset. Because you have perennial streams 
selected, the tool will sum up only the SUM field of these selected 
features.
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1) In the attribute table of the Los Angeles River layer, right-
click the DESCRIPTION field and click Summarize. 

2) Rename the output table LARiverPerennial by clicking the 
Browse button and entering the name. 

3) In the Field drop-down menu, click FEET, and in the 
Statistic Type menu, click SUM.

So you’re using the Summary Statistics tool to find the total length 
(sum of each FEET record) of the perennial portion of the LA River. 

4) In the Case field drop-down menu, click DESCRIPTION.

5) Compare the tool to the figure and click Run in the lower-
right corner of the Geoprocessing window. 

6) When the tool finishes processing, the resulting table is 
added to the bottom of the Contents pane. Right-click the 
table and click Open to see the results. Confirm that the total 
feet of perennial streams is 229,947.

7) At the top of the Los Angeles River attribute table panel, click 
the Clear Selection button .

Clearing the record selection clears the feature selection on the map 
and in the table.

8) Close the attribute tables of Los Angeles River and 
LARiverPerennial so that the map fills the middle of the 
application. You can also close the Summary Statistics pane now.

9) Save the project by clicking the Save button  at the top of 
the application.

Save your project often as you work through the workbook. 

Change the basemap to Imagery with Labels

Imagery provides a detailed, photorealistic view of the ground, and 
you’ll rely on it to explore the LA River in more detail. Imagery also 
has other important uses, such as providing a background against 
which to edit features (lesson 5) and “ground truthing” analysis 
results (lesson 6).

1) On the Map tab, click the Basemap drop-down arrow and 
click Imagery with Labels. 

World Imagery is added to the bottom of the Contents pane and 
replaces streets. A layer named World Boundaries and Places has 
also simultaneously been added to the top of the Contents pane. 
This layer consists of locations, boundaries, and labels and should be 

Selecting features   

You make selections to work with a 
subset of features in a layer. You can 
use a selection to zoom the map to 
a specific area, make a new layer 
from the selected subset, get statis-
tical information about the subset, 
or for many other things.
Selections are also used in queries. 
Whether you do an attribute query 
(to find records with a certain at-
tribute value) or a spatial query (to 
find features with a certain spatial 
relationship to other features), the 
records and features that satisfy the 
query are returned as a selection 
on the layer.

visible on the map. (You should see yellow place-names covering the 
city of Los Angeles feature, for instance). Your Contents pane and 
map should look like the figure. 

Create a bookmark 

Certain views in a map are useful for orientation or reference. You 
can bookmark a view to make it easy to return to.

1) First, zoom to the Los Angeles layer by right-clicking the Los 
Angeles layer and clicking Zoom to Layer.

2) On the Map tab, click Bookmarks > New Bookmark.

3) In the Create Bookmark dialog box, replace the default name 
with City of Los Angeles. Click OK. 

4) Zoom in on the river’s mouth at the Port of Long Beach by 
pressing and holding the Shift key.

5) In the lower-left corner of the map, click the Map Scale drop-
down arrow and click 1:10,000.

At this scale, one unit of measure on the map is equivalent to 
10,000 of the same units on the ground. Loosely, a thing on the 
map is 10,000 times smaller than its actual size.
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2) On the Map tab, click Bookmarks > New Bookmark.

3) In the Create Bookmark dialog box, replace the default name 
with City of Los Angeles. Click OK. 

4) Zoom in on the river’s mouth at the Port of Long Beach by 
pressing and holding the Shift key.

5) In the lower-left corner of the map, click the Map Scale drop-
down arrow and click 1:10,000.

At this scale, one unit of measure on the map is equivalent to 
10,000 of the same units on the ground. Loosely, a thing on the 
map is 10,000 times smaller than its actual size.
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6) Use the Zoom and Pan tools to explore the harbor. 

The imagery is high resolution, and you’ll see more detail as you 
keep zooming in. Eventually, you’ll reach a limit in the level of 
detail, and the image will become pixelated.

7) When you’re ready, on the Map tab, click Bookmarks > City 
of Los Angeles.

The map view returns to the bookmarked extent.

Change the symbology for Los Angeles 

The boundary of Los Angeles is filled in with a solid color so the 
imagery underneath is still covered up. Soon you’re going to zoom 
in and follow the river’s course through the city. It will serve that 
purpose to resymbolize the city so that you see only its outline.

1) In the Contents pane, click on the color symbol below the 
name Los Angeles to modify the symbol. 

The Symbology pane opens on the right side of the map.

2) Click Properties. If necessary, expand Appearance.

3) Change the color to No Color.

4) Change the outline color to Autunite Yellow. 

5) Increase the outline width to 2 pt.

6) Click Apply.

The new symbology is displayed on the map.

7) Close the Symbology pane.

Save the layer as a layer file 

It wasn’t hard to make this particular symbol, but it often takes time 
and effort to create good symbology. Having done so, you may want 
to reuse that symbology. In this book, for instance, you’ll draw the 
outline of Los Angeles in other map documents in coming lessons.

You can save layer properties to a file called a layer file, which has 
the file extension .lyrx. A layer file is not a copy of the data, but you 
add it to a map document in the same way that you add data. The 
layer file stores all the properties of a layer—its name, symbology, 
definition query, and so on—including the path to the layer’s source 
dataset. When you add a layer file to ArcGIS Pro, the layer draws 
with its properties already set.
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6) Use the Zoom and Pan tools to explore the harbor. 

The imagery is high resolution, and you’ll see more detail as you 
keep zooming in. Eventually, you’ll reach a limit in the level of 
detail, and the image will become pixelated.

7) When you’re ready, on the Map tab, click Bookmarks > City 
of Los Angeles.

The map view returns to the bookmarked extent.

Change the symbology for Los Angeles 

The boundary of Los Angeles is filled in with a solid color so the 
imagery underneath is still covered up. Soon you’re going to zoom 
in and follow the river’s course through the city. It will serve that 
purpose to resymbolize the city so that you see only its outline.

1) In the Contents pane, click on the color symbol below the 
name Los Angeles to modify the symbol. 

The Symbology pane opens on the right side of the map.

2) Click Properties. If necessary, expand Appearance.

3) Change the color to No Color.

4) Change the outline color to Autunite Yellow. 

5) Increase the outline width to 2 pt.

6) Click Apply.

The new symbology is displayed on the map.

7) Close the Symbology pane.

Save the layer as a layer file 

It wasn’t hard to make this particular symbol, but it often takes time 
and effort to create good symbology. Having done so, you may want 
to reuse that symbology. In this book, for instance, you’ll draw the 
outline of Los Angeles in other map documents in coming lessons.

You can save layer properties to a file called a layer file, which has 
the file extension .lyrx. A layer file is not a copy of the data, but you 
add it to a map document in the same way that you add data. The 
layer file stores all the properties of a layer—its name, symbology, 
definition query, and so on—including the path to the layer’s source 
dataset. When you add a layer file to ArcGIS Pro, the layer draws 
with its properties already set.
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1) In the Contents pane, right-click Los Angeles and click Save 
As Layer File (near the bottom of the context menu).

The Save Layer(s) As LYRX File dialog box opens. 

2) Click Folders at the top of the left column and open the 
ParkSite\MapsAndMore folder.

3) Name the new file LosAngeles (no spaces) and click Save. 

Now you’ll remove the Los Angeles layer that’s currently in the map, 
and then add the layer file to see how it works.

4) In the Contents pane, right-click Los Angeles and click 
Remove.

The layer disappears from the map and the Contents pane.

5) In the Project pane, browse to the MapsAndMore folder.

6) Drag the LosAngeles.lyrx file to your map. 

The layer is added to the map with all its properties set (layer name, 
symbology, definition expression, and so on).

7) Open the layer properties of Los Angeles. In the Layer 
Properties dialog box, click Source.

Note that as before, the layer points to the City_ ply feature class. 
As stated previously, layer files do not store raw data; they are a 
pointer to the GIS data along with the properties about how to dis-
play the data on a map.

8) Close the Layer Properties dialog box.

Anytime you add the LosAngeles.lyrx file to a map document, the 
layer will draw as a yellow outline with a definition query on the 
city of Los Angeles. Once the layer is added to the map, however, it’s 
just the same as any other layer, and you can change its properties 
however you want. (Not that you want to change them.)

Follow the river 

Now you can start developing a sense of the study area by following 
the river’s course through the city.

1) Maximize the ArcGIS Pro window if you haven’t done so 
already.

2) Open the City of Los Angeles bookmark.

3) Zoom in on the river’s source in the community of Canoga 
Park in northwest Los Angeles.

The river officially starts where Bell Creek and the Arroyo 
Calabasas converge at Canoga Park High School.

4) Click the Map Scale drop-down arrow below the map and 
click 1:24,000. 

5) Press and hold the left mouse button to pan slowly eastward 
along the river.

Densely populated residential neighborhoods line both sides of the 
river until you get to the Sepulveda Dam Recreation Area, a large 
recreational area with golf courses and a lake. The river bottom is 
natural here, becoming concrete again at the Sepulveda Dam in the 
southeastern corner of the basin. 

Setting map scale   

By default, map scale is displayed in 
the form of a representative frac-
tion, such as 1:24,000. At this scale, 
for any unit of measure, one unit of 
distance on the map is equivalent 
to 24,000 units in the real world. 
You can set the map to any scale 
you want by typing a number in the 
scale box and pressing Enter. You 
can also enter a verbal expression 
such as “1 inch = 1 mile,” and it will 
be converted to a representative 
fraction. To change the way that 
scale is displayed, or to change the 
list of predefined scales, click Cus-
tomize This List at the bottom of 
the Map Scale drop-down list.
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1) In the Contents pane, right-click Los Angeles and click Save 
As Layer File (near the bottom of the context menu).

The Save Layer(s) As LYRX File dialog box opens. 

2) Click Folders at the top of the left column and open the 
ParkSite\MapsAndMore folder.

3) Name the new file LosAngeles (no spaces) and click Save. 

Now you’ll remove the Los Angeles layer that’s currently in the map, 
and then add the layer file to see how it works.

4) In the Contents pane, right-click Los Angeles and click 
Remove.

The layer disappears from the map and the Contents pane.

5) In the Project pane, browse to the MapsAndMore folder.

6) Drag the LosAngeles.lyrx file to your map. 

The layer is added to the map with all its properties set (layer name, 
symbology, definition expression, and so on).

7) Open the layer properties of Los Angeles. In the Layer 
Properties dialog box, click Source.

Note that as before, the layer points to the City_ ply feature class. 
As stated previously, layer files do not store raw data; they are a 
pointer to the GIS data along with the properties about how to dis-
play the data on a map.

8) Close the Layer Properties dialog box.

Anytime you add the LosAngeles.lyrx file to a map document, the 
layer will draw as a yellow outline with a definition query on the 
city of Los Angeles. Once the layer is added to the map, however, it’s 
just the same as any other layer, and you can change its properties 
however you want. (Not that you want to change them.)

Follow the river 

Now you can start developing a sense of the study area by following 
the river’s course through the city.

1) Maximize the ArcGIS Pro window if you haven’t done so 
already.

2) Open the City of Los Angeles bookmark.

3) Zoom in on the river’s source in the community of Canoga 
Park in northwest Los Angeles.

The river officially starts where Bell Creek and the Arroyo 
Calabasas converge at Canoga Park High School.

4) Click the Map Scale drop-down arrow below the map and 
click 1:24,000. 

5) Press and hold the left mouse button to pan slowly eastward 
along the river.

Densely populated residential neighborhoods line both sides of the 
river until you get to the Sepulveda Dam Recreation Area, a large 
recreational area with golf courses and a lake. The river bottom is 
natural here, becoming concrete again at the Sepulveda Dam in the 
southeastern corner of the basin. 

Setting map scale   

By default, map scale is displayed in 
the form of a representative frac-
tion, such as 1:24,000. At this scale, 
for any unit of measure, one unit of 
distance on the map is equivalent 
to 24,000 units in the real world. 
You can set the map to any scale 
you want by typing a number in the 
scale box and pressing Enter. You 
can also enter a verbal expression 
such as “1 inch = 1 mile,” and it will 
be converted to a representative 
fraction. To change the way that 
scale is displayed, or to change the 
list of predefined scales, click Cus-
tomize This List at the bottom of 
the Map Scale drop-down list.
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East of the Sepulveda Basin, the river follows a freeway for a while 
and is again surrounded by fairly dense residential and commercial 
areas.

6) On the keyboard, press and hold the Q key.

Now you roam continuously across the display in whichever direc-
tion you point the mouse. To control your speed, make small brush-
ing movements with the mouse either with or against the direction 
of movement. As you roam, the imagery should draw smoothly and 
continuously, although your experience may vary. Other layers, such 
as the Los Angeles River layer, suspend drawing and catch up when 
you stop.

7) Release the Q key to stop roaming.

▶ You can also use the four arrow keys on the keyboard to roam.

8) Continue to pan (or roam) along the river.

The river flows generally southeast for a while, and then follows the 
northern edge of unincorporated Universal Studios. It continues 
east, and then bends sharply south as it curves around Griffith Park 
(at 4,218 acres, one of the largest city parks in the United States). 
To the north of Griffith Park lies the city of Burbank; to the east is 
Glendale.

As it flows south, the river runs parallel to another major freeway. 
You’ll see the Silver Lake Reservoir and then Elysian Park, where 
the Los Angeles Dodgers play Major League Baseball. 

Save your bookmarks 

Dodger Stadium is a landmark that you may want to return to so 
you can save the map location (or “extent”) as a bookmark.

1) Center your view on Dodger Stadium, more or less as shown 
in the figure.

2) On the Map tab, click Bookmarks > New Bookmark.

3) In the Create Bookmark dialog box, name the bookmark 
Dodger Stadium and click OK.

Pan to the city limits 

You’ll follow the river until it crosses the LA city limits, which 
marks the boundary of your study area.

1) Pan along the river as it runs south.

This last section of river passes through an industrial landscape and 
leaves the city at the Redondo Junction train yards.
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East of the Sepulveda Basin, the river follows a freeway for a while 
and is again surrounded by fairly dense residential and commercial 
areas.

6) On the keyboard, press and hold the Q key.

Now you roam continuously across the display in whichever direc-
tion you point the mouse. To control your speed, make small brush-
ing movements with the mouse either with or against the direction 
of movement. As you roam, the imagery should draw smoothly and 
continuously, although your experience may vary. Other layers, such 
as the Los Angeles River layer, suspend drawing and catch up when 
you stop.

7) Release the Q key to stop roaming.

▶ You can also use the four arrow keys on the keyboard to roam.

8) Continue to pan (or roam) along the river.

The river flows generally southeast for a while, and then follows the 
northern edge of unincorporated Universal Studios. It continues 
east, and then bends sharply south as it curves around Griffith Park 
(at 4,218 acres, one of the largest city parks in the United States). 
To the north of Griffith Park lies the city of Burbank; to the east is 
Glendale.

As it flows south, the river runs parallel to another major freeway. 
You’ll see the Silver Lake Reservoir and then Elysian Park, where 
the Los Angeles Dodgers play Major League Baseball. 

Save your bookmarks 

Dodger Stadium is a landmark that you may want to return to so 
you can save the map location (or “extent”) as a bookmark.

1) Center your view on Dodger Stadium, more or less as shown 
in the figure.

2) On the Map tab, click Bookmarks > New Bookmark.

3) In the Create Bookmark dialog box, name the bookmark 
Dodger Stadium and click OK.

Pan to the city limits 

You’ll follow the river until it crosses the LA city limits, which 
marks the boundary of your study area.

1) Pan along the river as it runs south.

This last section of river passes through an industrial landscape and 
leaves the city at the Redondo Junction train yards.
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2) Close the Lesson1a map view (not the entire project) and any 
open tables.

3) Save your project.

4) Continue to the next lesson or close ArcGIS Pro. Save your 
changes if prompted.

Results for the book’s exercises can be found online on the book’s 
resource web page. For information on how to download and use 
the Results data, go to esri.com/Understanding-GIS-3. 

Exercise 1b: Do exploratory data analysis
In this exercise, you’ll add park data and census data (containing 
demographic and socioeconomic information) to your map. The 
goal is to pay attention to patterns in the data and thereby build 
an intuitive sense of likely and unlikely locations for the park. This 
intuition should give you confidence that the analysis results you get 
in lesson 6 are plausible. Conversely, if the results contradict your 
gut feeling, you may be alerted to possible mistakes in the analysis.

Get started

You’ll start ArcGIS Pro, if necessary, and continue working with 
your project document from the last lesson.

1) Start ArcGIS Pro. 

From the Project pane, you’ll make a copy of your Lesson1a map 
and name it Lesson1b. You can easily copy and paste maps in the 
Maps section of the Project pane similar to how you copy and paste 
files on your computer. 

2) If necessary, expand the Maps item in the Project pane.

3) Right-click the Lesson1a map and click Copy.

4) Right-click the Maps item (the folder above Lesson1a) and 
click Paste. 

5) Rename the copy of Lesson1a as Lesson1b.

6) Open the lesson1b map by double-clicking the map in the 
Project pane. 

Add a layer of parks 

The Parkland feature class can be found in ParkSite > SourceData > 
ESRI.gdb > Landmark > Parkland.

1) Add the Parkland layer by dragging it to the map.

One of your geographic constraints is that the new park not be 
located too close to existing parks. You know from your exploration 
so far that there are a couple of big parks along the river, but now 
you can look at the whole scenario.

Symbolize the layer 

A shade of green is usually the right cartographic choice for parks. 
ArcGIS Pro may have chosen one by a stroke of luck, but probably 
not. You’ll symbolize the layer after taking a look at its extent.

1) In the Contents pane, right-click the  
Parkland layer and click Zoom To Layer. 

2) In the Contents pane, turn Parkland off and on a few times 
by clicking its check box. Leave it turned on. 

The data extends well beyond Los Angeles, and the basemap shows 
that those big polygons to the north correspond to mountains. 
They’re probably national forests. 
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Add a layer of parks 

The Parkland feature class can be found in ParkSite > SourceData > 
ESRI.gdb > Landmark > Parkland.

1) Add the Parkland layer by dragging it to the map.

One of your geographic constraints is that the new park not be 
located too close to existing parks. You know from your exploration 
so far that there are a couple of big parks along the river, but now 
you can look at the whole scenario.

Symbolize the layer 

A shade of green is usually the right cartographic choice for parks. 
ArcGIS Pro may have chosen one by a stroke of luck, but probably 
not. You’ll symbolize the layer after taking a look at its extent.

1) In the Contents pane, right-click the  
Parkland layer and click Zoom To Layer. 

2) In the Contents pane, turn Parkland off and on a few times 
by clicking its check box. Leave it turned on. 

The data extends well beyond Los Angeles, and the basemap shows 
that those big polygons to the north correspond to mountains. 
They’re probably national forests. 
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3) In the Contents pane, click the color patch under the 
Parkland layer name to open the Symbology pane. 

4) Switch from the Gallery tab to the Properties tab and click 
the Color button to open the color palette. Click Apple Dust, 
a shade of green.

5) Click the Outline color button to open the color palette 
again.

6) Click Moss Green. 

7) Click Apply in the Symbology pane.

The layer symbology is updated on the map.

Identify features 

Now you can find out what attributes this layer has in the table.

1) On the Map tab, verify that the Explore tool is active by 
clicking on it. 

2) Click on one of the big park features in the mountains to 
identify it.

Moss Green

Among the attributes are the park’s name, its type, and its acreage.

3) Leave the pop-up window open. On the Map tab, in the 
Navigate group, click Bookmarks > City of Los Angeles. 

At this scale, you can make out the larger parks within the city.

4) Try to locate the parks mentioned earlier: the Sepulveda Dam 
Recreation Area, Griffith Park, and Elysian Park. Click on 
each one to see its attributes.

5) When you’re done, leave the Identify  
window open and zoom to the Dodger  
Stadium bookmark. 

6) Identify some of the neighborhood-size 
parks in the view.

7) Close the pop-up window. 

Your list of park requirements doesn’t have an 
upper size limit, but you can expect your candi-
dates to be under 10 acres. Your trip down the 
river in the previous exercise didn’t reveal any 
great big tracts of open land that weren’t already 
parks.

Label the parks layer 

Some of the larger parks are already labeled in the World 
Boundaries and Places layer, but many of the smaller ones are not.

1) With the Parkland layer selected in the Contents pane, click 
the Labeling tab above the map and, in the Layer group, click 
the Label button  on the far left of the ribbon.

The parks are labeled with their names in simple black text. The 
information is being taken from the NAME attribute in the 
Parkland attribute table. 

The default labels aren’t ideal for this map. The black text disappears 
into the imagery wherever the label doesn’t fit inside the park. In 
addition, the labels appear on one line, no matter how long they are.
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3) In the Contents pane, click the color patch under the 
Parkland layer name to open the Symbology pane. 

4) Switch from the Gallery tab to the Properties tab and click 
the Color button to open the color palette. Click Apple Dust, 
a shade of green.

5) Click the Outline color button to open the color palette 
again.

6) Click Moss Green. 

7) Click Apply in the Symbology pane.

The layer symbology is updated on the map.

Identify features 

Now you can find out what attributes this layer has in the table.

1) On the Map tab, verify that the Explore tool is active by 
clicking on it. 

2) Click on one of the big park features in the mountains to 
identify it.

Moss Green

Among the attributes are the park’s name, its type, and its acreage.

3) Leave the pop-up window open. On the Map tab, in the 
Navigate group, click Bookmarks > City of Los Angeles. 

At this scale, you can make out the larger parks within the city.

4) Try to locate the parks mentioned earlier: the Sepulveda Dam 
Recreation Area, Griffith Park, and Elysian Park. Click on 
each one to see its attributes.

5) When you’re done, leave the Identify  
window open and zoom to the Dodger  
Stadium bookmark. 

6) Identify some of the neighborhood-size 
parks in the view.

7) Close the pop-up window. 

Your list of park requirements doesn’t have an 
upper size limit, but you can expect your candi-
dates to be under 10 acres. Your trip down the 
river in the previous exercise didn’t reveal any 
great big tracts of open land that weren’t already 
parks.

Label the parks layer 

Some of the larger parks are already labeled in the World 
Boundaries and Places layer, but many of the smaller ones are not.

1) With the Parkland layer selected in the Contents pane, click 
the Labeling tab above the map and, in the Layer group, click 
the Label button  on the far left of the ribbon.

The parks are labeled with their names in simple black text. The 
information is being taken from the NAME attribute in the 
Parkland attribute table. 

The default labels aren’t ideal for this map. The black text disappears 
into the imagery wherever the label doesn’t fit inside the park. In 
addition, the labels appear on one line, no matter how long they are.
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2) On the Labeling ribbon, in the Text Symbol group, change 
the font to Arial (near the top).

3) Click the Color button. On the color palette, change the text 
color to Lemongrass. 

Light-green text will show up better than black, but to be legible it 
still needs an outline, or halo.

4) Click the launcher button  in the Text Symbol group to 
open the Label Class pane.

5) On the Symbol tab, expand the Halo group.

6) Click the selector arrow next to the Halo symbol, click White 
fill under Polygon symbols, and click Apply (at the bottom of 
the pane). The default halo color is white, but you’re going to 
use something darker.

7) Click the Color selector under Halo and click Moss Green. 

8) Click Apply to see the result on the map.

On the map, the park labels are visible against the basemap. 

Set a scale range for the labels 

The park labels look good at this fairly large scale, where there’s 
room to accommodate them. Now you can see what happens when 
you zoom out.

1) Zoom to the City of Los Angeles bookmark, located on the 
Map tab.

At this smaller (zoomed-out) scale, the labels 
overwhelm the map. You could just turn 
them off, of course, whenever they seem too 
crowded. A better solution is to make their 
visibility depend on the map scale. 

2) With the Parkland layer selected, open the Labeling (not 
Appearance) ribbon.

3) In the Visibility Range group, click in the Out Beyond box 
and type 40,000 (not 1:40,000). Then press Enter. The park 
labels turn off instantly because you are zoomed out beyond 
1:40,000. Whenever the map scale crosses the 1:40,000 
threshold, the park labels will turn off automatically. 

4) Zoom to the Dodger Stadium bookmark. 

As long as the map scale is larger than 1:40,000 (which means it is 
zoomed in closer than 1:40,000), the labels show up again. 

You’ve probably noticed that some parks, such as Elysian Park and 
Echo Park, are labeled in both the World Boundaries and Places 
and Parkland layers. You can set the scale range of the World 
Boundaries and Places layer reciprocally to the Parkland labels.

5) With the top World Boundaries and Places layer selected, 
open the Appearance ribbon (there should be no Labeling or 
Data options).
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2) On the Labeling ribbon, in the Text Symbol group, change 
the font to Arial (near the top).

3) Click the Color button. On the color palette, change the text 
color to Lemongrass. 

Light-green text will show up better than black, but to be legible it 
still needs an outline, or halo.

4) Click the launcher button  in the Text Symbol group to 
open the Label Class pane.

5) On the Symbol tab, expand the Halo group.

6) Click the selector arrow next to the Halo symbol, click White 
fill under Polygon symbols, and click Apply (at the bottom of 
the pane). The default halo color is white, but you’re going to 
use something darker.

7) Click the Color selector under Halo and click Moss Green. 

8) Click Apply to see the result on the map.

On the map, the park labels are visible against the basemap. 

Set a scale range for the labels 

The park labels look good at this fairly large scale, where there’s 
room to accommodate them. Now you can see what happens when 
you zoom out.

1) Zoom to the City of Los Angeles bookmark, located on the 
Map tab.

At this smaller (zoomed-out) scale, the labels 
overwhelm the map. You could just turn 
them off, of course, whenever they seem too 
crowded. A better solution is to make their 
visibility depend on the map scale. 

2) With the Parkland layer selected, open the Labeling (not 
Appearance) ribbon.

3) In the Visibility Range group, click in the Out Beyond box 
and type 40,000 (not 1:40,000). Then press Enter. The park 
labels turn off instantly because you are zoomed out beyond 
1:40,000. Whenever the map scale crosses the 1:40,000 
threshold, the park labels will turn off automatically. 

4) Zoom to the Dodger Stadium bookmark. 

As long as the map scale is larger than 1:40,000 (which means it is 
zoomed in closer than 1:40,000), the labels show up again. 

You’ve probably noticed that some parks, such as Elysian Park and 
Echo Park, are labeled in both the World Boundaries and Places 
and Parkland layers. You can set the scale range of the World 
Boundaries and Places layer reciprocally to the Parkland labels.

5) With the top World Boundaries and Places layer selected, 
open the Appearance ribbon (there should be no Labeling or 
Data options).
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6) In the Visibility Range group, click in the In Beyond box and 
type 40,001. 

Notice that some default options were already set here. These are 
defaults that are set for this hosted basemap.

By setting this option, the entire top World Boundaries and Places 
layer turns off when zoomed in at a larger scale than 1:40,001. Most 
of these labels are actually for places other than parks, but you can 
accept their loss at large scales.

7) Zoom back and forth across  
the 1:40,000 scale threshold  
to test your settings.

At scales of 1:40,000 or larger,  
the World Boundaries and Places  
layer appears with a dimmed  
check box in the Contents pane.  
This dimmed check box tells you  
that the layer is turned on but is  
set not to show at the current  
map scale. 

 

Dim the basemap 

Without doing anything further to the labels, you can emphasize 
them a little more by dimming the imagery basemap. To do that, 
you’ll adjust its transparency.

1) With the bottom World Imagery layer selected, open the 
Appearance ribbon. 

2) From the Effects group, adjust the transparency slider to 10%. 
You can do so by dragging the slider to 10%, or by typing 
10 in the box. On the map, notice that the basemap fades 
slightly. 

Scale ranges   

As you’ve just seen, scale ranges 
can be set both for a layer’s labels 
and for the layer itself. In this case, 
the distinction was blurred because 
the Reference layer is composed of 
labels. But layers that are composed 
of features, such as parks or rivers, 
can have their scale ranges set in 
exactly the same way. When you 
design maps to be viewed at multi-
ple scales, you normally want layers 
representing detailed data, such as 
buildings or utility lines, to be vis-
ible only at large (close-up) scales. 
You may want your map to include 
multiple copies of a layer, each with 
a different scale range and unique 
symbology. For example, one layer 
might represent trees with a gener-
ic point symbol at medium scales. 
A second layer might represent the 
same trees with a more detailed 
and realistic symbol at large scales.

Add a layer of census tracts 

The US Census Bureau gathers socioeconomic data about house-
holds and aggregates it by various geographic units. One of these 
units is a census tract, which is a relatively small subdivision of a 
county.

1) Open the Project pane and browse to ParkSite > SourceData 
> census. 

2) Drag the tracts shapefile to the map.

The tracts layer is added to the Contents pane. The tracts cover 
everything except the labels.

3) In the Contents pane, right-click the tracts layer and click 
Zoom To Layer.

The census tract data covers Los Angeles County, including the 
islands of Catalina and San Clemente.

4) Zoom to the City of Los Angeles bookmark.

The tracts layer is made up of contiguous polygons that are reminis-
cent of a jigsaw puzzle. Because each piece of the puzzle represents a 
different set of living, breathing human beings, it’s natural that each 
tract’s attribute values for population, income, age, and so on would 
be different. 
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6) In the Visibility Range group, click in the In Beyond box and 
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layer turns off when zoomed in at a larger scale than 1:40,001. Most 
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accept their loss at large scales.
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the 1:40,000 scale threshold  
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At scales of 1:40,000 or larger,  
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check box in the Contents pane.  
This dimmed check box tells you  
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set not to show at the current  
map scale. 
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representing detailed data, such as 
buildings or utility lines, to be vis-
ible only at large (close-up) scales. 
You may want your map to include 
multiple copies of a layer, each with 
a different scale range and unique 
symbology. For example, one layer 
might represent trees with a gener-
ic point symbol at medium scales. 
A second layer might represent the 
same trees with a more detailed 
and realistic symbol at large scales.

Add a layer of census tracts 

The US Census Bureau gathers socioeconomic data about house-
holds and aggregates it by various geographic units. One of these 
units is a census tract, which is a relatively small subdivision of a 
county.

1) Open the Project pane and browse to ParkSite > SourceData 
> census. 

2) Drag the tracts shapefile to the map.

The tracts layer is added to the Contents pane. The tracts cover 
everything except the labels.

3) In the Contents pane, right-click the tracts layer and click 
Zoom To Layer.

The census tract data covers Los Angeles County, including the 
islands of Catalina and San Clemente.

4) Zoom to the City of Los Angeles bookmark.

The tracts layer is made up of contiguous polygons that are reminis-
cent of a jigsaw puzzle. Because each piece of the puzzle represents a 
different set of living, breathing human beings, it’s natural that each 
tract’s attribute values for population, income, age, and so on would 
be different. 
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Open the attribute table 

Now you can see what attributes the table contains.

1) In the Contents pane, right-click the tracts layer and click 
Attribute Table.

2) Scroll across the table and look at the field names.

The table has some identification codes, followed by selected popula-
tion and housing attributes. Some of the field names are fairly easy 
to interpret, others less so. In lesson 2, you’ll see how to get more 
information about your information by accessing the metadata. 

3) Locate the POPDENS_CY field. CY stands for current year, 
which for this census data is 2015.

This attribute stores population density (people per square mile) for 
the year 2015. Because one of your criteria is to locate the park in a 
densely populated area, this is relevant information. The attribute 
doesn’t tell you what value should be a threshold for “high density,” 
but it gives you a way to start making patterns on a map. Close the 
table when you are finished looking at it. 

Symbolize census tracts by population density 

Symbolizing a layer by an attribute, also called thematic mapping, 
allows you to see how values are spatially distributed.

1) With the tracts layer selected in the Contents pane, open the 
Symbology pane by clicking Symbology on the Appearance 
ribbon.

By default, all features in a layer have a single symbol. That’s why all 
your census tracts are purple, or whatever color they happen to be.

2) In the Symbology drop-down list, click Graduated Colors. 
The map updates automatically on the basis of some default 
values.

3) In the Field drop-down list, click POPDENS_CY. On the 
map, the tracts are symbolized by population density.

4) Change the Color scheme to Yellow to Red. 

You can view the names of the schemes by clicking the Show names 
check box at the bottom of the list. Additional color schemes are 
available by clicking the Show all check box. 

A lot is going on here if you expand the Symbol chart. (The same 
information is also available in the Contents pane.) The values for 
the POPDENS_CY attribute, which range from 0 to 96,824.5, are 
divided into five classes. The starting and ending values for each 
class are calculated by a “natural breaks” algorithm that separates 
clumps in the data. That’s why the range of values is different from 
class to class and why classes break at seemingly arbitrary numbers. 
Each class is associated with a symbol in a color ramp and is dis-
played on the map. 

Change the classification 

Quantitative symbology is flexible, and you can present data in many 
ways. Because all you want right now is a general sense of viable areas 
for your project, and because you’re going to look at a couple of vari-
ables together, you should keep your presentation simple.
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Open the attribute table 

Now you can see what attributes the table contains.

1) In the Contents pane, right-click the tracts layer and click 
Attribute Table.

2) Scroll across the table and look at the field names.

The table has some identification codes, followed by selected popula-
tion and housing attributes. Some of the field names are fairly easy 
to interpret, others less so. In lesson 2, you’ll see how to get more 
information about your information by accessing the metadata. 

3) Locate the POPDENS_CY field. CY stands for current year, 
which for this census data is 2015.

This attribute stores population density (people per square mile) for 
the year 2015. Because one of your criteria is to locate the park in a 
densely populated area, this is relevant information. The attribute 
doesn’t tell you what value should be a threshold for “high density,” 
but it gives you a way to start making patterns on a map. Close the 
table when you are finished looking at it. 

Symbolize census tracts by population density 

Symbolizing a layer by an attribute, also called thematic mapping, 
allows you to see how values are spatially distributed.

1) With the tracts layer selected in the Contents pane, open the 
Symbology pane by clicking Symbology on the Appearance 
ribbon.

By default, all features in a layer have a single symbol. That’s why all 
your census tracts are purple, or whatever color they happen to be.

2) In the Symbology drop-down list, click Graduated Colors. 
The map updates automatically on the basis of some default 
values.

3) In the Field drop-down list, click POPDENS_CY. On the 
map, the tracts are symbolized by population density.

4) Change the Color scheme to Yellow to Red. 

You can view the names of the schemes by clicking the Show names 
check box at the bottom of the list. Additional color schemes are 
available by clicking the Show all check box. 

A lot is going on here if you expand the Symbol chart. (The same 
information is also available in the Contents pane.) The values for 
the POPDENS_CY attribute, which range from 0 to 96,824.5, are 
divided into five classes. The starting and ending values for each 
class are calculated by a “natural breaks” algorithm that separates 
clumps in the data. That’s why the range of values is different from 
class to class and why classes break at seemingly arbitrary numbers. 
Each class is associated with a symbol in a color ramp and is dis-
played on the map. 

Change the classification 

Quantitative symbology is flexible, and you can present data in many 
ways. Because all you want right now is a general sense of viable areas 
for your project, and because you’re going to look at a couple of vari-
ables together, you should keep your presentation simple.
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1) Change the Classes drop-down box to 3.

2) Set the classification method to Quantile.

Using three classes, you’ll easily be able to see high, medium, and 
low values. The quantile method guarantees that an equal number 
of tracts will fall into each class. It should be noted that there are 
no inherently good or bad ways to classify data—different classifica-
tions may be more or less appropriate to the purpose of your map 
and the background knowledge of your audience.

3) Change the first upper value to 8000 by double clicking the 
label, typing the value into the Upper value cell, and pressing 
Enter. The second class break point is selected and editable. 

4) Change the second upper value to 16000. 

Notice that the classification method has been reset to Manual 
Interval because you’ve changed the class breaks. The histogram is 
updated, too. You no longer have a pure quantile classification, but 
having your classes break at round numbers makes intuitive sense.

The outlines of the polygons are currently overwhelming the map in 
some of the areas with the highest densities, making it difficult to 
interpret the classifications. 

5) Click the More button in the Class breaks area of the 
histogram, and then browse to Symbols > Format all symbols. 
Any changes made here will apply to all the classifications.

6) If necessary, change to the Properties tab (near the top of the 
pane). Change the Outline color to No Color. 

7) Click Apply at the bottom of the pane, and then click the 
back arrow at the top of the Symbology pane to return to the 
classification settings.

You’re removing the outlines because you don’t need to see the tract 
boundaries on the map. For now, you’re interested in them as areas, 
not specifically as tracts.

8) In the Label column, double-click on the first label (< 8000) 
to make it editable. Type Low and press Enter.

▶ If you start typing in the wrong box (in this case, Upper value), 
change the classification method to Natural breaks to reset 
the upper value, and then begin typing in the correct box, 
Label.

9) Replace the second label with Medium. Press Enter.

10) Change the third label to High. Click outside the edit box to 
commit the edit. 

11) Change the transparency of the tracts layer to 50% (from the 
Appearance ribbon). 

12) In the Contents pane, drag the tracts layer under the 
Parkland layer.

On the map, you can now see where population is concentrated 
along the river, and you can see it in relation to existing parks. 
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Measure distance from the river to parks 

Making a few measurements will improve your ability to estimate 
distance on the map and give you a better intuitive sense of how 
close to the river the new park should be.

1) Select the Dodger Stadium bookmark (if necessary, turn off 
the tracts layer).

2) Pan the map so that a number of parks are in the view. Feel 
free to zoom in or out.

3) On the Map tab, in the Inquiry group, click the Measure > 
Measure Distance button to open the Measure Options. 

4) Click the Options drop-down arrow. Set the Distance units 
to Miles and turn off Feet. 

On the map, the pointer changes to a ruler with inscribed cross 
hairs.

5) Move the pointer over a park, such as Cypress Park (northeast 
of Dodger Stadium on the east side of the river). 

6) Click to start a measurement.

7) Move the pointer (you don’t have to drag it) to the river. The 
measurement result is displayed along the line and in the 
Measure dialog box.

8) Double-click to end the measurement.

9) Click on another park and measure its distance to the river.

The new result replaces the previous one in the Measure dialog box.

10) Measure the distances from a few more parks.

Cypress Park, Elysian Valley Recreation Center Park, and Downey 
Playground are close to the river. Elyria Canyon Park, a little over 
three quarters of a mile away (at its nearest edge), stretches the 
notion of proximity. Bear in mind that these measurements are 
straight-line distances, not the distance along streets.

11) Switch back to the Explore tool . The Measure tool stays 
active until another tool is selected.

12) Zoom to the City of Los Angeles bookmark.

Add a layer of census block groups 

Another requirement for the new park is that it be located in a 
lower-income neighborhood. To symbolize an income attribute, you 
must add another layer to the map. (It’s not that income data isn’t 
reported at the census tract level, it’s just that your particular tracts 
layer doesn’t happen to include it.)

The same census folder that contains tracts.shp also has a shapefile 
dataset named block_groups.shp.

1) Open the Project pane and add the block_groups shapefile to 
the map from ParkSite > SourceData > census. 

The new layer is added above the other layers. Like the tracts layer, 
the block_ groups layer covers Los Angeles County. And like the 
census tracts, the block group polygons resemble a jigsaw puzzle. 
Block groups are another Census Bureau statistical unit: they’re 
smaller than tracts and nest inside them. We’ll talk more about cen-
sus geography in lesson 2.

2) Open the attribute table of the block_groups layer and scroll 
across the attributes.

Most of these attribute names are cryptic. One of the last fields in 
the table is called MEDHINC_CY. For now, take it on faith that 
this acronym stands for median household income. 

3) Close the attribute table.

Symbolize census block groups by median 
household income

If you symbolize the block_groups layer with graduated colors, you 
won’t be able to evaluate income and population density at the same 
time. Instead, you’ll represent each block group’s median household 
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straight-line distances, not the distance along streets.
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active until another tool is selected.
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Another requirement for the new park is that it be located in a 
lower-income neighborhood. To symbolize an income attribute, you 
must add another layer to the map. (It’s not that income data isn’t 
reported at the census tract level, it’s just that your particular tracts 
layer doesn’t happen to include it.)

The same census folder that contains tracts.shp also has a shapefile 
dataset named block_groups.shp.

1) Open the Project pane and add the block_groups shapefile to 
the map from ParkSite > SourceData > census. 

The new layer is added above the other layers. Like the tracts layer, 
the block_ groups layer covers Los Angeles County. And like the 
census tracts, the block group polygons resemble a jigsaw puzzle. 
Block groups are another Census Bureau statistical unit: they’re 
smaller than tracts and nest inside them. We’ll talk more about cen-
sus geography in lesson 2.

2) Open the attribute table of the block_groups layer and scroll 
across the attributes.

Most of these attribute names are cryptic. One of the last fields in 
the table is called MEDHINC_CY. For now, take it on faith that 
this acronym stands for median household income. 

3) Close the attribute table.

Symbolize census block groups by median 
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If you symbolize the block_groups layer with graduated colors, you 
won’t be able to evaluate income and population density at the same 
time. Instead, you’ll represent each block group’s median household 
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income as a point drawn inside the block group polygon. The point 
sizes will be graduated according to the income value.

1) Using the Appearance tab, open the Symbology pane for the 
block_groups layer.

2) In the Symbology drop-down list, click Graduated Symbols.

3) In the Field drop-down list, click MEDHINC_CY.

4) Click the Classes drop-down arrow and click 3. 

5) Replace the first value with 50000 and the middle value with 
100000 and press Enter.

6) Click the Template symbol (underneath the Minimum size 
drop-down box) to open the Format Point Symbol pane.

7) Under Properties, click the Color button and change its color 
to Tourmaline Green. 

8) Click Apply and then the back button at the top of the pane. 
This symbology sets the color and shape of the symbols that 
will be used to represent income values.

9) Click Background (on the right of Template) to open the 
Format Point Symbol pane again.

10) Change Color to No Color, if necessary, and then change the 
Outline color to No Color. 

11) Click Apply and then the back button at the top of the pane.

This symbology makes the block group polygons themselves invis-
ible. All you’ll see are the income dots spread around the map.

12) Change the Minimum size to 8.

13) Change the Maximum size to 24.

14) In the Label column, double-click on the first label (< 50000) 
to make it editable. Type Low and press Enter.

15) Replace the second label with Medium. Press Enter.

16) Change the third label to High. Press Enter.

At the present scale, the symbols overwhelm the map. 

Set a scale range for the block_ groups layer 

Earlier, you set a maximum scale value for the World Boundaries 
and Places layer. Here, you’ll set a minimum value for the block_ 
groups layer.

1) With the block_groups layer selected in the Contents pane, 
open the Appearance ribbon.

2) Click in the Out Beyond box and type 100000. Press Enter.

The symbols disappear from the map. In the Contents pane, the 
layer’s dimmed check box indicates that the layer is turned on but is 
not visible at the current map scale.
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income as a point drawn inside the block group polygon. The point 
sizes will be graduated according to the income value.

1) Using the Appearance tab, open the Symbology pane for the 
block_groups layer.

2) In the Symbology drop-down list, click Graduated Symbols.

3) In the Field drop-down list, click MEDHINC_CY.

4) Click the Classes drop-down arrow and click 3. 

5) Replace the first value with 50000 and the middle value with 
100000 and press Enter.

6) Click the Template symbol (underneath the Minimum size 
drop-down box) to open the Format Point Symbol pane.

7) Under Properties, click the Color button and change its color 
to Tourmaline Green. 

8) Click Apply and then the back button at the top of the pane. 
This symbology sets the color and shape of the symbols that 
will be used to represent income values.

9) Click Background (on the right of Template) to open the 
Format Point Symbol pane again.

10) Change Color to No Color, if necessary, and then change the 
Outline color to No Color. 

11) Click Apply and then the back button at the top of the pane.

This symbology makes the block group polygons themselves invis-
ible. All you’ll see are the income dots spread around the map.
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to make it editable. Type Low and press Enter.

15) Replace the second label with Medium. Press Enter.
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At the present scale, the symbols overwhelm the map. 

Set a scale range for the block_ groups layer 

Earlier, you set a maximum scale value for the World Boundaries 
and Places layer. Here, you’ll set a minimum value for the block_ 
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3) Zoom to the Dodger Stadium bookmark.

4) Click the Fixed Zoom Out button a couple of times until 
some of the Medium and High symbols begin to appear.

5) Turn the tracts layer back on. if necessary.

Now you can start to get a general sense of household income and 
population density along the river, and look at these variables in 
relation to park locations. 

Search for likely park areas 

Clearly, you’re taking an incomplete initial look at a complex prob-
lem. You haven’t considered all the requirements (for example, the 
presence of children). You’re not making any exact measurements 
of distance. Your data classifications are casual: you don’t yet have 
a good reason to say what values should count as high population 
density or low median household income in the context of your 
project. Nevertheless, you can form some meaningful impressions. 
You won’t be able to say of an area that a park should definitely go 
there, but you might be able to identify likely and unlikely areas. 
Later, it will be interesting to see how well these impressions are 
borne out by analysis.

1) In the Map Scale box at the bottom of the map pane, 
highlight the current value. Type 40000 and press Enter.

2) Pan south to where the river crosses the city boundary.

3) In the Contents pane, drag the Los Angeles River layer to the 
position just below the World Boundaries and Places layer (it 
may already be there).

You’ll follow the river to its source, marking good areas for a park 
along the way. A really good area would have these properties:

• high population density (dark red),
• low median household income (small green dot),
• no existing park nearby, and
• close to the river.

4) Pan slowly north.

Less than a mile north of the city limits, on the east side of the river, 
are a couple of tracts—one dark red and one medium red—with 
small green dots. They’re pretty close to the river, and even though 
there are some parks in the general vicinity, it’s probably worth 
marking the area as a potential park. 
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3) Zoom to the Dodger Stadium bookmark.
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marking the area as a potential park. 
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To mark the area, you’ll use a feature of ArcGIS Pro called Map 
Notes. Map Notes are layer templates that create point, line, and 
polygon feature classes in your Home database with predefined 
symbols for feature creation and editing.

5) On the Insert tab, in the Layer Templates group, click the 
Bright Map Notes button. 

Clicking the button adds a new group layer to your Contents pane 
named Bright Map Notes.

6) Expand the Bright Map Notes layer to see that it contains 
point, line, and polygon layers.

7) Expand the three layers to see their predefined symbols. 

8) Collapse the Bright Map Notes group by clicking the little 
arrow on the left of the check box.

9) In the Project pane, browse and expand your home database 
in the Databases group. Notice that three new feature classes 
have been added to the geodatabase. These classes are the 
data sources for the Map Notes layers that were added to the 
map. 

Create a new feature

You will now create a new feature in the feature class.

1) Go to the Edit tab.

2) In the Features group, click the Create button . 

This button opens the Create Features pane on the right of the 
map. This pane allows you to draw new features in any of the layers 
marked as editable in the map. By default, all layers are editable so 
you will change that so that you don’t accidentally add new rivers, 
parks, census tracts, and so on. 

3) In the Contents pane, click the List By Editing button  
above the layer list. 

This list now displays all the layers with a check box next to each 
one to define whether they are editable or not.

4) Click to clear all but the Bright Map Notes layers (you will 
probably have to expand the group layer to confirm that they 
are checked). 

Notice that as you click to clear the other layers, the Create Features 
pane on the right of the map changes to show only those features 
that are editable. 

5) Switch back to the List by Drawing Order view by clicking 
the  button at the top of the Contents pane.

6) Add a purple star point near the areas of interest by clicking 
the Star 4 icon from the Create Feature pane on the right side 
of the application and then clicking the spot on the map.

▶ To stop adding stars, click the Explore button. To delete 
unwanted stars, click the Undo button.
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To mark the area, you’ll use a feature of ArcGIS Pro called Map 
Notes. Map Notes are layer templates that create point, line, and 
polygon feature classes in your Home database with predefined 
symbols for feature creation and editing.

5) On the Insert tab, in the Layer Templates group, click the 
Bright Map Notes button. 

Clicking the button adds a new group layer to your Contents pane 
named Bright Map Notes.

6) Expand the Bright Map Notes layer to see that it contains 
point, line, and polygon layers.

7) Expand the three layers to see their predefined symbols. 

8) Collapse the Bright Map Notes group by clicking the little 
arrow on the left of the check box.

9) In the Project pane, browse and expand your home database 
in the Databases group. Notice that three new feature classes 
have been added to the geodatabase. These classes are the 
data sources for the Map Notes layers that were added to the 
map. 

Create a new feature

You will now create a new feature in the feature class.

1) Go to the Edit tab.

2) In the Features group, click the Create button . 

This button opens the Create Features pane on the right of the 
map. This pane allows you to draw new features in any of the layers 
marked as editable in the map. By default, all layers are editable so 
you will change that so that you don’t accidentally add new rivers, 
parks, census tracts, and so on. 

3) In the Contents pane, click the List By Editing button  
above the layer list. 

This list now displays all the layers with a check box next to each 
one to define whether they are editable or not.

4) Click to clear all but the Bright Map Notes layers (you will 
probably have to expand the group layer to confirm that they 
are checked). 

Notice that as you click to clear the other layers, the Create Features 
pane on the right of the map changes to show only those features 
that are editable. 

5) Switch back to the List by Drawing Order view by clicking 
the  button at the top of the Contents pane.

6) Add a purple star point near the areas of interest by clicking 
the Star 4 icon from the Create Feature pane on the right side 
of the application and then clicking the spot on the map.

▶ To stop adding stars, click the Explore button. To delete 
unwanted stars, click the Undo button.
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Continue searching for park areas 

You’ll keep following the river and looking for likely places for a 
park.

1) Click the Explore button on the Map tab and pan north.

A little farther north, again on 
the east side of the river, is a 
medium-density, lower-income 
area with just one park (Pecan 
Playground) in the general vicin-
ity. You’d prefer a high-density 
neighborhood, but since you 
don’t yet have specific criteria for 
your analysis, you want to be 
inclusive rather than exclusive in 
your assessments. It’s up to you 
whether to mark this area or 
not—all that really matters is 
that you start to gain a sense of 
the study area. 

2) Add another purple star in this area by going back to the Edit 
tab and clicking the Star 4 icon.

The area opposite Dodger Stadium, on the east side of the river, is 
medium density, lower income, and park poor, which makes it rich 
with possibility for a new park site. 

3) Add another purple star in this area.

4) Mark any other areas that seem promising to you.

As you navigate around Griffith Park, remember that the yellow 
line marks the city limits. The areas north and east of the park 
aren’t part of Los Angeles and shouldn’t be considered. Once you 
get around this park, you may find fewer likely areas. But remember, 
there’s no right or wrong answer for this exercise.

5) When you’re finished marking promising locations, zoom to 
the layer Bright – Point Notes. 

6) Save your edits by clicking the Save button  in the Manage 
Edits group. 

7) When prompted to save all Edits, click Yes.
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The area opposite Dodger Stadium, on the east side of the river, is 
medium density, lower income, and park poor, which makes it rich 
with possibility for a new park site. 

3) Add another purple star in this area.

4) Mark any other areas that seem promising to you.

As you navigate around Griffith Park, remember that the yellow 
line marks the city limits. The areas north and east of the park 
aren’t part of Los Angeles and shouldn’t be considered. Once you 
get around this park, you may find fewer likely areas. But remember, 
there’s no right or wrong answer for this exercise.

5) When you’re finished marking promising locations, zoom to 
the layer Bright – Point Notes. 

6) Save your edits by clicking the Save button  in the Manage 
Edits group. 

7) When prompted to save all Edits, click Yes.
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8) Close the Create Features pane.

9) Close the Lesson1b map and any open tables.

10) Save your project.

11) Continue to the next lesson or close ArcGIS Pro. Save your 
changes if prompted.

Now that you’ve explored the study area around the Los Angeles 
River, you will begin to list the data requirements for the project 
and begin previewing the data that meets your project needs. This 
data can also help you reframe your problem and park criteria in 
more detail by replacing general guidelines with hard numbers and 
thresholds.




